
 
 

  

ACTIMETRICS’  
 

CLOCKLAB ANALYSIS 
 

SOFTWARE  
 

MANUAL 

ACT-500



 

CLOCKLAB ANALYSIS 
 

Installing the ClockLab Analysis Program ........................................................................................................... 1 
System Requirements...................................................................................................................................... 1 
Install MATLAB. ................................................................................................................................................ 1 
Download the Toolbox Files............................................................................................................................ 1 
Install the Toolbox: .......................................................................................................................................... 1 
Registration....................................................................................................................................................... 1 

The Main Window Controls ................................................................................................................................. 2 
Handling Data Files .......................................................................................................................................... 2 
General Analysis Controls .............................................................................................................................. 2 

Actogram Controls .............................................................................................................................................. 3 
Other Analyses..................................................................................................................................................... 5 
Saving Configurations......................................................................................................................................... 5 

Making Figures and Slides ..................................................................................................................................... 5 
Preferences Window............................................................................................................................................ 6 

Open File Preferences ..................................................................................................................................... 6 
Graph Preferences ........................................................................................................................................... 6 

Actogram Preferences......................................................................................................................................... 6 
Periodogram Preferences ................................................................................................................................... 8 
The Activity Profile Window................................................................................................................................ 8 

Window Controls .............................................................................................................................................. 8 
The Profile Menu............................................................................................................................................... 8 

The Actogram Window............................................................................................................................................ 9 
Quick Start ........................................................................................................................................................ 9 
Measuring Event Times (Shift-Click) .............................................................................................................. 9 
Navigating Through the Data Using the Actogram....................................................................................... 9 
Displaying Light/Dark Cycles........................................................................................................................ 10 
Daily Activity Measures ................................................................................................................................. 11 
Least-Squares Fits to Daily Measures ......................................................................................................... 12 
Calculating Phase Shifts ............................................................................................................................... 13 
Predicting Activity Onset............................................................................................................................... 13 
Bout Analysis.................................................................................................................................................. 14 
Event Markers ................................................................................................................................................. 14 
File Notes ........................................................................................................................................................ 14 
Printing the Actogram.................................................................................................................................... 14 
Opening the Next File .................................................................................................................................... 14 
Altering the Actogram's Appearance ........................................................................................................... 15 
Saving the Actogram ..................................................................................................................................... 15 

The Autocorrelation Window ............................................................................................................................ 15 
Bout Analysis.................................................................................................................................................. 16 
Event Markers ................................................................................................................................................. 16 
File Notes ........................................................................................................................................................ 16 

The FFT Window ................................................................................................................................................ 16 
FFT plotting preferences ............................................................................................................................... 17 

The Periodogram Windows............................................................................................................................... 17 
Chi-squared Periodogram ............................................................................................................................. 18 
F Periodogram ................................................................................................................................................ 18 
Lomb-Scargle Periodogram .......................................................................................................................... 19 
References ...................................................................................................................................................... 19 

The Time Series Window................................................................................................................................... 20 
The Batch Analysis Window................................................................................................................................. 20 
The Batch Print Window ....................................................................................................................................... 22 

 



1

 

Installing the ClockLab Analysis Program 
System Requirements.  

The CLOCKLAB Analysis application will run on Macintosh or Window 9X/NT/2000 computers. 
Almost any computer will do, but especially for long files some of the calculations can be memory- and 
CPU-intensive. We recommend at least a 233 MHz Pentium 2 or G3 computer with 64 Mbytes of 
memory. 

Install MATLAB  

CLOCKLAB is a Toolbox that runs within the MATLAB environment. If you haven,t already, you must 
first install MATLAB. Contact The Mathworks, Inc. 
info@mathworks.com 
24 Prime Park Way 
http://mathworks.com 
Natick, MA 01760 
Phone: 508-647-7000  
You need only the basic MATLAB system. None of the extra Mathworks toolboxes are required to run 
CLOCKLAB. When you order Matlab, you must specify which computer operating system (Macintosh 
or Windows) you will be using. CLOCKLAB will run on either. We’ve never tried Sun computers, but 
there is no reason ClockLab shouldn’t run on them as well.  

Download the Toolbox Files 

Install the Toolbox:  

•  Unzip the file CircadianAnalysis.zip  

•  Place the Circadian directory in the Matlab/Toolbox directory.  

•  Place the file "startup.m" in the Matlab/Toolbox/local directory.  

•  Start Matlab. Clocklab should start automatically.  

Registration  

When you first run CLOCKLAB, a window appears displaying your CLOCKLAB serial number and 
asking for your password. You must obtain your password from Actimetrics. Have your serial number at 
hand when you call or e-mail.  
Coulbourn Instruments 
7462 Penn Drive 
Allentown, PA  18106 
Phone: (610) 395-3771 
Fax: (610) 391-1333 
E-mail: sales@coulbourn.com 
 
Once you have your password, run CLOCKLAB again. Click on the text-edit box labeled PASSWORD, 
and type in the number supplied. Press ENTER or click anywhere outside the text-edit box. With the 
correct password, the registration window will disappear and the main window will appear. Your 
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password and serial number are stored in a file within theMatlab\Toolbox\ CircadianPrefs folder. As 
long as this file is not disturbed, you should not have to enter your password again. But keep your serial 
number and password in a safe place just in case.  

 

The Main Window Controls 
Handling Data Files 

Open File displays a standard Open File dialog. Select a data file. Once the file is open, information 
about the file is displayed below the Open File button, including the file name and duration of the data in 
the file. In addition, the Start Date and End Date menus are filled in with the starting and ending days 
and dates (if known) of the file's data. 

When the Preserve Dates button (Preferences Window) is not checked, the Start and End Date 
controls are set to the start and end dates of the new file.If the Preserve Dates option is checked, the 
program attempts to preserve the current settings of the main window Start Date and End Date 
controls. If, however, the current Start Date or End Date settings are beyond the range of dates 
contained in the newly opened file, the controls are set to the beginning and ending dates of the file.  

CLOCKLAB currently reads data files in the following formats: 

•  CLOCKLAB data collection format  

•  Stanford Software's Chronobiology Kit  

•  ASCII files created by Mini-Miter's VitalView program  

•  ASCII formatted DATA QUEST files  

•  Circadia files  

•  Actiwatch files  

CLOCKLAB automatically detects which type of file has been selected and interprets the data 
accordingly. 

When CLOCKLAB opens a file, it looks through the data for discontinuities or gaps. Gaps in the 
records are filled with zeroes for most analyses. Gaps can be indicated in the Actogram when the Show 
Gaps option (Preferences Window) is checked. 

If the time stamps for adjacent hours for some reason run backwards, no warning will be given and 
CLOCKLAB will not attempt to fix the error. Unexpected results might occur. 

Next File opens the file the name of which follows alphabetically the name of the currently open file.  

Append. Appends data from the selected file to the data from the currently open file(s). To append a 
series of files, start with Open File and select the earliest of the files in the series. Then select Append 
for each of the additional files in turn, proceeding in order according to the starting dates of the files.  

General Analysis Controls  

These controls affect the calculation and display of all analyses, such as actograms, periodograms and 
activity profiles.  
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Blocksize. With Blocksize set to a value greater than one, the data are smoothed by averaging together 
the selected number of adjacent data points (minutes) prior to any calculation or display. Possible values 
insure that the averaging generates an integer number of data points per hour. Especially for actograms 
and periodograms of large files, using a blocksize of less than 3 will greatly slow calculations. In 
addition, with long files, MATLAB might run out of memory while displaying an actogram or 
periodogram. Choose a larger blocksize, or increase MATLAB’s available memory. To increase 
memory on the Macintosh, highlight MatLab’s icon, select GetInfo from the File menu (GetInfo-
>Memory in System 8.5) and choose a larger "preferred size".  

Start/End Dates. These menus contain a list of the dates for which data were collected, together with 
the number of each day. These menus are used to set the range of data from which all calculations and 
graphs are made. When a new file is opened, CLOCKLAB attempts to preserve the current settings of 
these menus. If, however, the new file does not include data with the dates currently set in the Start/End 
menus, the menus are set to the first and last dates in the file. 

All. Clicking this button sets Start Date to day 1, and End Date to the last day of the file.  

Start Hour. Determines the hour within the Start Date where all analyses and displays begin. This 
control is particularly important for the Actogram display.  

Write File. Once you have appended multiple files it can sometimes be useful to create a new file 
containing the combined data set. By doing so can avoid having to append the multiple files each time 
you want to analyze the complete data set. Use the Write File button to create a file that ClockLab can 
read from the data currently in memory. You can write all the data, or the part of the data specified by 
the Start/End Dates controls using the All and Use Dates buttons underneath the Write File button. 
Note that Write File is very different from the Export function in the Time Series Window: Write File 
creates a data file that is readable only by ClockLab; Export creates a data file in text or spreadsheet 
format, which is not directly readable by Clocklab. 

Tau affects the appearance of the Actogram and the Activity Profile. The top item of the popupmenu 
sets Tau to exactly 24 hours. The bottom item displays a text box just below the menu where a Tau of 
other than 24 hours may be entered. Tau can also be set automatically from the Periodogram windows 
(see below). Tau is also relevant to the display of Activity Profiles (see below).  

 

Actogram Controls  
Actogram. Displays an actogram.  

Several controls alter the appearance and function of the actogram. Note that changing any of these 
settings will not change an actogram that is already displayed. For the changes to take affect, you must 
replot the actogram by clicking on the Actogram button.  

Type. Four types of actogram can be displayed.  

•  Percentile distribution. After averaging according to the Blocksize control, the activity counts 
are compiled into a list and sorted by value. Zeros are discarded from this list. Each non-zero 
activity count is assigned a number between 1 and N depending on whether the activity is lies 
within the first 1/Nth of the ordered list, the 2nd, 3rd, and so on. These numbers are displayed in 
the actogram. N, the number of quantiles, defaults to 5 and can be changed in the Preferences 
window  
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•  Even distribution. Similar to percentile distribution above, except that the numbers between 
1 and N are assigned depending on whether the count values lie between 0 and maxcount/N, 
between maxcount/N and 2*maxcount/5, and so on, where maxcount is the largest count 
recorded during the display period.  

•  Threshold. Each point is assigned a value of 0 or 1 depending on whether it is less than or 
greater than the threshold. The threshold is set in the threshold text box that appears just below 
the Type menu when Threshold is selected.  

o You may specify that the threshold be set to the mean or median of the data points by 
typing "mean" or "median" into the threshold text box.  

o You may specify that the threshold for each line be set to the mean or the median of the 
data within that line by typing "line mean" or "line median" into the threshold text box.  

•  Scaled. The actual count value is displayed. The vertical scaling is controlled by the value(s) 
entered into the scale text box that appears just below the Type menu. Click the Auto button to 
scale the data actogram to fit the full range of the data. Enter values into the textbox to customize 
the scale.  

o With one value entered into the scale textbox ("50", for example), the vertical scale on 
each line of the actogram starts at 0, and a value of 50 will just fill one line of the 
actogram.  

o With two values entered into the textbox ("50 100", for example), the vertical scale starts 
at 50 and a value of 100 will just fill the actogram. Values below 50 will not be visible. 
This feature is useful for displaying temperature or heart-rate data, which contain large 
offsets from 0.  

o To subtract the offset (minimum value) of the data set before scaling, select the Subtract 
Offset checkbox.  

•  Normalized. Each line of the actogram is scaled individually to fill the line. 0 and the largest 
value displayed in a given line of the actogram correspond to the minimum and maximum values 
of the data for that line.  

Y Scale. Controls the number of days that are displayed in the actogram. 

•  Auto scales the actogram vertically so that the entire data range specified by Start/End Date 
menus fits within the actogram window. The actogram is zoomable.  

•  Fixed fixes the vertical scale to contain the number of lines you specify in the text box under the 
menu. The actogram will not be zoomalbe. A set of controls will appear within the actogram 
window that allows you to page through the data, maintaining the fixed y scale.  

•  NU E-A Hor and NU E-A Vert fix the Yscale with the number of lines per graph adjusted to 
mimic the handmade Esterline-Angus records previously used by the Northwestern University 
circadian rhythm labs. These two setting also automatically turn on the Double-plot option.  

Preferences opens a window in which some less frequently changed details of the program function can 
be set.  
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Other Analyses 
Time Series. Displays counts per minute vs. time in a single graph. 

Activity Profile. Data are divided into Tau-length periods and averaged.  

Periodograms. Three different types of periodogram can be displayed by selecting the appropriate item 
in the popupmenu. 
The Chi-squared periodogram of Bushell and Sokolove.  
The F periodogram of Dorrscheift and Beck. 
The Lomb-Scargle periodogram. 
FFT. Displays a Fourier transform of the activity counts. 

AutoCorr. Displays an autocorrelogram of the activity counts. 

Batch Processing 

Batch print. Opens a window for starting printing actograms or periodograms for multiple files at once.  

Batch analysis. Opens a window for extracting various parameters from multiple files.  

 

Saving Configurations 
ClockLab saves most settings in the main window and Preferences window in the file " _whconfig.mat", 
which is located in the CircadianPrefs toolbox directory. This file is read every time clocklab is run and 
the settings restored to the values they had when ClockLab was last run. To restore the settings to their 
defaults, simply discard the _whconfig.mat file.  

Parameters saved include the Current Data Directory, Actogram Type, Threshold, and Y Scale, Auto 
Open, Double Plot, LD Bar, Tau, Block Size, Start Hour, Font, Onset Template Fit, Light Display Color 
and Mode, and FFT, and Periodogram options. 

Save Setting and Recall Settings. Different users may have different standard preferences for many of 
the control setting. Or one user may use different settings for different groups of data files. Save 
Settings allows you to create a a personal settings file. Recall applies the settings in a settings file 
(selected with a standard OpenFile dialog).  
 

Making Figures and Slides 
At any time, you may capture an image of any one of CLOCKLAB’s graphics windows into the 
clipboard for transfer to another program.  

1. Bring the desired figure to the foreground,  

2. In Windows select the Copy Figure item from the File menu at the top of the figure window.  

3. On a Macintosh, type Command-C, or use the Copy item in the Edit menu.  

4. Enter another program and select Paste.  
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Note: Some programs in Windows might require the use of a Paste Special command. In Corel Draw, 
for example, choose Paste Special from the edit menu and select "Picture (Enhanced Metafile)" from the 
Paste Special window. All of the elements of the figure except the control buttons and text boxes should 
appear in the pasted graphic. 

Prior to copying the actogram into the clipboard, the controls (buttons, popup menus, etc.) in the 
Actogram window may be suppressed by unselecting the "Show Controls" checkbox in the Preferences 
window. 

In programs with drawing capabilities, such as Corel Draw, Power Point and Claris Draw, you may 
ungroup the graphic and edit all of its elements by moving, resizing, reshaping or coloring them, 
changing text fonts, and so on. You may also add graphics elements such as arrows and labels.  
 

Preferences Window 
The preferences window is used for setting some of the less-frequently changed program attributes. It is 
accessible from the Preferences button in the Main window and from a Prefs button in many of the 
analysis windows. Note that these settings are saved in the ClockLab configuration files (see the Main 
Window Save Settings control) and are therefore preserved from session to session. To restore the 
settings to the "factory default", discard the file _whconfig.mat in the folder 
Matlab\Toolbox\CircadianPrefs. 

Open File Preferences 

Preserve Dates: When checked, the program attempts to preserve the current settings of the main 
window Start Date and End Date controls when a new file is opened. If either the Start Date setting or 
the End Date setting are beyond the range of dates contained in the newly open file, the controls are set 
to the beginning and ending dates of the file. When the Preserve Dates button is not checked, the Start 
and End Date controls are automatically set to the start and end dates of the newly opened file. 

Update Graphs: When this option is checked and a new file is opened using the Open File, Next File, 
or Append File buttons, any open graph (Actogram, Periodogram, FFT etc.) is updated to display the 
newly opened file. 

Graph Preferences 

Graph Color (Black): When checked, the background color of the analysis windows (excepting the 
Actogram window) are displayed in black.  

Select Font. Opens a standard dialog for selecting the font, font size and style that is used for labels and 
axes in all graphs. The current selections are shown in the text box below. 

 

Actogram Preferences 
Light Display Color. If you are reading files made by the ClockLab data collection program or by 
Actiwatch, the light levels in the animal chambers can be recorded in the data files. This button opens a 
color selection dialog to select the color of the light display. 
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Light Display Modes. 
Fill. When checked, the light levels are displayed as a filled histogram. When unchecked, the light levels 
are displayed as a single line. 

Behind. The light levels can be plotted in front of or behind the count data. Usually, Fill and Behind 
will be selected together.  

XOR. When XOR is checked, the color of the actogram plot where it overlaps the light plot will change 
color.  
Lightplot Height. The relative heights of the light plot and actogram plot can be adjusted. With a 
setting of 1, the plots are set so that maximum light level and the maximum counts fill the line. 

Onset Fit Template. ClockLab finds the time of activity onset or offset by matching the activity pattern 
to a template. The default template is 6 hours of inactivity followed by 6 hours of activity (or vice versa 
for offsets). This template may be inappropriate for files in which the daily activity bouts are fairly 
short. You can change the template using the two menus.  

Show:  
Zero Lines. When checked, causes black lines to be drawn at Counts=0 for each line of the actogram. 

Data Gaps. When checked, causes colored lines to be drawn at Counts=0 wherever there are gaps in the 
data. Line color is chosen with the accompanying popup menu. 

Show Controls. When unchecked, prevents the various checkboxes, popup menus and buttons from 
appearing in the actogram. This is useful when the actogram is being copied into the clipboard and 
pasted into drawing programs for figure preparation. 

Double Plot Divider. Causes a vertical line to appear at Circadian time 0 in double-plotted actograms. 

Onsets. This options automatically activates the Show button in the actogram window.The Actogram 
therefore opens with activity onsets visible.  

Open Onset File. Automatically activates the Read button in the actogram window. Thus, the program 
automatically looks for and loads a file called _filename-onsets.mat and applies the information 
contained in the file to the alter the appearance of the actogram. The file must have been previously 
created using the Save button in the actogram window, and contains information including edited onsets, 
onset fits, settings for start and end dates, tau, etc. See Saving the Actogram in the Actogram window for 
details. Note that this control is useful only when the Onsets option is also checked. Checking Open 
Onset File therefore causes the Onsets to be checked as well. 
Quantiles.Selects the number of activity levels that will be used for calculating "Percentile" and "Even" 
actograms. See Main Window Controls for further explanation. 

Bout analysis settings. Activity bouts are identified as periods during which the activity (counts/min) 
does not fall below a threshold for more than a specified gap length. Use the Threshold and Max Gap 
controls to set these two parameters. The color selector sets the color of the bout onset markers that 
appear in the histogram window. 
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Periodogram Preferences 
Periodogram Range. Specifies the Start and End period (in hours) for the x-axis of the periodogram. 
The defaults are 10 and 36 hours. The resolution for F and Chi-squared periodograms is determined by 
the BlockSize control in the Main Window. With BlockSize set to 6, for example, the periodogram will 
be plotted at a period resolution of 10 points per hour. With BlockSize set to much less than 6, the 
periodogram calculation can take a significantly longer time and require large amounts of memory. 
Lomb-Scargle periodograms are calculated with a fixed resolution of 0.05 hours. 

Identify Arrhythmics. This item relates to the Periodogram Peak analysis in the Batch Analysis 
window. When checked, arrhythmic animals (those in which the periodogram never exceeds the chi-
square line) are identified in the output file by the notation, "NaN" (Not a Number). 

Confidence level. For Chi-squared periodograms, specifies the confidence level (alpha) from which the 
chi-square line is calculated. For a confidence level of 0.01, for example, the chances of random data 
exceeding the chi-square line at any one point is 1/100. 
 

The Activity Profile Window 
The activity profile shows a plot of the average activity as a function of circadian time for the dates 
specified by the Start and End Dates menus in the Main Window.  

Window Controls 

Cursors. Drag the two cursor points (colored dots on the graph line) to specify the Rho and Alpha 
periods. To move a cursor, click near it and drag to the desired position. As you drag, the x-axis location 
of the cursor is displayed in the corresponding color-coded "Position" text box below the graph. At the 
same time, the summed activity counts between the cursors is displayed to the left in the "Counts" text 
box. The sum of the counts outside the cursors is displayed to the right.  

Cursor Position Text Boxes. When the cursors is dragged, the corresponding Position text box is 
updated to indicate the x-axis location of the cursor. Alternatively, you may enter a value into either 
Position text box (in the current x-axis units), and the corresponding cursor will move to the specified 
position. Double-click the text box, type the desired value and press the <Enter> key. 

The Profile Menu 

UNITS. Using the UNITS item in the PROFILE menu in the window's menu bar, the x-axis can be 
labeled in dgrees (t/Tau*360), hours, circadian hours or % Tau. 

SEM. Displays the SEM of each data point as a shaded region surrounding the main trace. 

MEAN/MEDIAN. Places a horizontal line in the activity profile at the mean or median of the graph. 
This control also determines whether a mean or median line appears in a batch printing of activity 
profiles. 

EXPORT. Displays counts for each individual day in the MATLAB command window and saves the 
counts to a spreadsheet compatible file. The file also contains the raw data (time and counts/day) of the 
activity profile plot. You will be prompted for a file name in which these count data are saved in 
spreadsheet format. Click Cancel to prevent the file from being created. The saved data include: 

•  Day number  
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•  counts between cursors (alpha count)  

•  counts outside cursors (rho count)  

•  total counts  
 

The Actogram Window  
The actogram window in CLOCKLAB is more than just a passive graphic display. It contains many 
controls and menus that make it a sophisticated analysis tool that is the source of much of ClockLab's 
power and convenience. The controls are fairly straightforward, but take some time to familiarize 
yourself with them. 

Quick Start 

•  Click and drag to zoom - double click to unzoom to the data range set in Main window 
Start/End Date controls. Click the All button to see the entire data set.  

•  Click the Set button to set the Start/End Date controls in main window to the zoomed data 
range.  

•  Shift-click to display the time at a given point (and phase shift if onset fits have been drawn).  

•  CTRL-click to place an event marker. CTRL-click on an existing marker to remove it. Move the 
cursor on top of a marker to display its label.  

•  The popup menu at the bottom left of the actogram displays various measures of daily activity, 
such as onset, offset, acrophase, bathophase, max and min.  

•  With onsets, or other measures visible: Click the Edit button to edit the displayed points. Click 
anywhere in a data line to move an onset - double click on onset to delete it. Click the Zoom 
button to revert to the default (zoom) mode for the actogram.  

•  With Light-Dark bar visible: Click and drag in bar to place a light indicator - double click to 
remove it. 

Measuring Event Times (Shift-Click) 

Shift-Click in the actogram window. Near the cursor, a text box will appear displaying: 

•  The time of day in hours when the counts under the cursor were recorded. If TAU is not 24 
hours, the displayed time will not correspond to the cursor’s x-position in the graph.  

•  Time in circadian hours relative to activity onset (displayed only if activity onsets are displayed).  

•  Activity phase shifts (displayed only if Fit 1 and Fit 2 are displayed).  

Navigating Through the Data Using the Actogram 

The actogram is an excellent tool for navigating through long records, when the main window Y-Scale 
control is set to “Auto”. 
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•  Click and drag within the actogram plot box to zoom the vertical axis. To display lines 20 to 40 
of the actogram, for example, click and hold anywhere along line 20, then drag to line 40 and 
release the mouse. Only the vertical extent of the dotted zoom box is used for zooming.  

•  Double-click anywhere in the plot box to zoom out again to the limits set by the main window 
Start Date and End Date controls. Note that when TAU is not 24 hours, the number of 
lines displayed in the actogram will not correspond exactly to the number of days set in the 
START and END DATE controls.  

•  The All button zooms out to show the entire file, no matter what the setting of the Main Window 
Start/End Date controls.  

•  Set Dates. Once you have zoomed the actogram to view a particular range of days, clicking 
the Set Dates button sets the Main Window Start/End Date controls to the data range currently 
displayed in the actogram. For example, zoom the actogram to show an interesting part of the 
data and click the Set Dates button. All subsequent analyses, such as FFT's or Periodograms are 
performed on the portion of the data visible in the actogram.  

When the Y Scale is set to the “Fixed” mode in the Main Window, zooming in the actogram window is 
disabled. If the data span more days than the maximum number of days within the actogram window, 
the Next and Last buttons scroll through the data one page at a time.  

Displaying Light/Dark Cycles 

The Light/Dark Plot  

When the LD BAR option in the Actogram menu is checked, a long, narrow rectangle appears above the 
actogram. Clicking and dragging within this rectangle places dark bars within it. The bars can be used 
to indicate the light/dark cycle applied during data collection. Double-clicking on a bar deletes it. To 
help you position the bars with precise starting and ending times, the horizontal position of the cursor 
within the bar is displayed (in hours) in the yellow rectangle to the right. 

Recorded Light Cycles  

The CLOCKLAB data collection program can record not only the activity counts, but a record of the 
lights within the animal chamber. When the opened file was collected using the CLOCKLAB data 
collection program, the LIGHTS item in the ACTOGRAM menu is enabled. Select this item to toggle 
the light-cycle display on and off. The light-cycle display consists of a colored background that indicates 
the times at which the lights were on. 

You can change the appearance of the light-cycle display by clicking on the Preferences button in the 
Main Window (or selecting the Preferences item from the ACTOGRAM menu). 

Drawing a Light Schedule 

Even if you did not record the light cycle during an experiment, you may draw in the cycle on the 
actogram.  
Choose ADD PATCH from the SCHEDULE menu in the actogram window. The cursor changes shape 
to indicate that you may now click and drag a rectangle in the actogram window. The yellow indicators 
at the upper right will help you set the patch onset and offset times and dates precisely. You may add as 
many patches as you like. 

Choose DELETE PATCH from the SCHEDULE menu and click on a patch to delete it. 
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Choose the CLEAR ALL menu item to erase all patches.  

Choose the COLOR menu item to display a standard color-picker dialog. Very light colors (a light cyan 
or grey, for example) work best. More saturated colors will alter the color of the actogram bars in a 
disconcerting way. 

Once a schedule is completely defined, you may save it to a file for applying to other actograms. Use the 
SAVE and READ items in the SCHEDULE menu to do so. Schedules are defined with respect to the 
first day in the file, and not the actual date.  

The AUTOREAD menu item allows you to choose a schedule file that will be applied automatically to 
every actogram that you open. Select the AUTOREAD item again to disable this feature.  

Schedules are also saved in the actogram configuration files (see Saving the Actogram below). A 
schedule in an Actogram configuration file will supercede a schedule in an automatically opened 
schedule file.  

Daily Activity Measures 

The Show popup menu displays the several different measures of daily activity. Measures are displayed 
as red dots, and the actogram data are dimmed to make the dots more visible. 
Onset and Offset times are estimated using a template matching algorithm (see below). With the default 
setting, ClockLab searches for a 6-hour period of inactivity followed by a 6-hour period of high activity. 
The time of day that best approximates this pattern is taken to be the activity onset time. For many files, 
the 6hr/6hr template is inappropriate and the estimates are incorrect. In this case, the template can be 
modified in the "Onset Fit Template" section of the Preferences window (select the Preferences item 
from the Actogram menu). For files containing short bouts of activity, for example, try reducing the 
template on time. 
    To detect activity onsets and offsets, ClockLab first bins the activity record according to the setting of 
the BlockSize control in the main window. The program then determines the 20th percentile activity 
level, that is, that activity level that exceeds exactly 20% of all non-zero counts. The activity record is 
then converted into a stream of 1's and -1's depending on whether each count exceeds or falls below the 
20% percentile. This threshold activity record is then convolved with a template that consists of N hours 
of -1's followed by M hours of 1's, where M and N are the Off and On settings in the Onset Fit section 
of the Preferences Window. The onset time for each line in the actogram is placed at the location of the 
maximum of this convolution. Offsets are likewise determined using a template of M hours of activity 
followed by N hours of inactivity. 

Acrophase and Bathophase are calculated by fitting each day's activity (binned according to Blocksize) 
to a sine function of period equal to TAU. Acrophase and Bathophase show the peak and trough of the 
resulting sine wave. 

Max and Min show the maximum and minimum activity value for each day (again, binned according to 
Blocksize). If two bins have the same max or min value, the first one is shown.  

Bouts. See below. 
Measuring circadian time. Once the activity onsets have been calculated, it is possible to measure the 
time of events in circadian hours. With the onsets displayed, shift-click anywhere within the actogram. 
Along with the real time (line one) appears the circadian time (line 2). Circadian time is defined as 12 
plus the real-time difference between the cursor location (t1) and the activity onset (t2) for the day you 
have clicked on, times 24, divided by Tau, or (t1-t2)*24/Tau + 12.  
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Editing Onsets. For many files, the onset calculation algorithm is extremely accurate in identifying 
activity onset time. In those cases when it is not, however, the onset times can be adjusted by hand. To 
do so,  
Click the Edit Onsets button. The actogram zoom feature is disabled, the Edit Onset button label 
changes to Zoom, and the cursor changes to a crosshair. Click the button again to turn off the onset 
editing mode and resume zooming. 

Click within a line of the actogram to move the onset time for that day to the horizontal position of the 
cursor.  

Double-click a point to delete it (if, for example, the animal did not run that day).  

Click the Save button to save your changes to a file that can be recalled later (see Saving the Actogram, 
below). 
Exporting Onsets. The ONSET -> EXPORT menu exports the onset and offset times for each day to a 
spreadsheet file. For each day specified by the Main Window Start/End Date controls, the file reports: 

•  Onset time  

•  Offset time  

•  FIT1 time (if FIT1 has been specified. See below.)  

•  FIT2 time (if FIT2 has been specified)  

•  Alpha counts (the counts between FIT1 time and FIT2 time). If necessary, FIT2 is extrapolated 
to cover the same range of days as FIT2.  

•  Rho counts (the counts between FIT2 time on day N and FIT1 time on day N+1). Counts for the 
last day of FIT1 are not reported.  

•  Total counts (the sum of alpha and rho).  

Serial Correlation. The ONSET -> SERIAL CORRELATION menu displays a scatterplot of the 
interval between onset N+1 and N+2 against the interval between onset N and N+1. A least squares fit to 
the scatterplot is also displayed, along with parameters of the fit. 

Automatic onset display. Selecting the Show Onsets option in the Preferences Window causes the 
actogram to be opened with onsets visible (i.e., as if the Show Onsets button had been clicked). 

Least-Squares Fits to Daily Measures 

Fit 1 and Fit 2. Displaying a daily activity measure (except Bouts) makes two additional controls 
visible, Fit 1 and Fit 2. These buttons generate least-squares fits to a group of the points displayed in the 
actogram window. After clicking one of the buttons, click-and-drag over the region of the actogram for 
which you want the fit to be calculated. Click without dragging to cancel. Along with each fitted line, a 
menu appears showing  

•  Tau: the slope of the line in hours per day  

•  Error: the standard deviation of the horizontal distance of the points from the line  

•  Mean: the mean time of the line  

•  Alpha: the difference between means for Fit 1 and Fit 2  
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•  Set Tau. When selected, sets the Main Window Tau control to the Tau specified by the slope of 
the fitted line.  

•  Counts: Displays the number of counts in the alpha and rho periods defined by the current fits to 
the onsets and offsets. Alpha counts are the counts between the onset fit and offset on a given 
day. Rho counts are counts from the offset of one day to the onset of the next. The counts are 
reported only for those days covered by Fit 1, except for the last day. Counts for the last day of 
the fit are not reported since the end of the rho period is undefined for that day. If necessary, Fit 
2 is extrapolated to cover the same range of days as Fit 1. Fit 1 must be fit to the onsets and Fit 2 
to the offsets, and Fit 1 must be positioned to the left of Fit 2, or an error is generated. Note that 
the count data can also be exported to a spreadsheet file using the ONSET -> EXPORT item in 
the ACTOGRAM menu (see above).  

•  Export: Exports the 4 values in the parameter menu to a file called "_OnsetFitData", located in 
the same folder as the currently open file. The values (together with the file name) are appended 
to _OnsetFitData if it already exists.  

Ext. The fitted lines created by Fit 1 and Fit 2 extend only over the region of the actogram containing 
fitted points (the region you dragged over). Ext extends the fitted lines to the borders of the actogram. 
Click again to hide the extended lines.  

Exporting the fits to a spreadsheet. You may export the daily times specified by the fitted lines (along 
with the times of the onset and offset times) to a spreadsheet file by selecting the ONSETS -> EXPORT 
item from the Actogram Menu (see above).  

Calculating Phase Shifts  

The least-squares fits to activity onsets make possible an automated calculation of phase shifts. To make 
the measurement, apply the fits to two different data periods. Then SHIFT-click anywhere on the line 
where the phase shift occurred. The bottom line of the three-line display that appears near the cursor 
gives the phase shift in circadian time, that is, the number of hours between the points at which Fit 1 and 
Fit 2 cross the day you have clicked on, times 24, divided by Tau, or (t1 - t2)*24/Tau. In most cases, you 
will place the fits on non-overlapping data periods, so the fit lines will not both visibly cross the day on 
which you measure the phase shift. No matter. CLOCKLAB internally extrapolates the lines to that day 
when it makes the calculation. You will notice that unless the two lines are perfectly parallel, the phase 
shift will be different depending on which day you shift-click on. To see the actual crossing points of the 
two fitted lines, click the Ext button (see above).  

Predicting Activity Onset 

The least-squares fits to activity onsets are useful for predicting future activity onset times. Imagine, for 
example, that an experiment is in progress that calls for delivering a stimulus or drug at a certain time 
prior to activity onset in a free-running animal. The least squares fit for the last several days of data can 
establish the current Tau. Extrapolating the fitted line to the following day will then give the most 
accurate prediction of activity onset.  

Zoom in on the last several days of data (preferably with a stable Tau), select Fit 1 and then select 
Predict. The y-axis of the actogram is adjusted to include one more day at the bottom of the plot. A blue 
* appears on that day where the Fit 1 line intersects it. The time of day for the prediction is printed in the 
Matlab Command Window. Or Shift-click on the * to display the time of day of the prediction.  
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Bout Analysis 

Display Bouts by selecting BOUTS from the popup menu at the bottom left of the actogram.  

Four items in the BOUT submenu of the ACTOGRAM menu control bout analysis.  

•  SHOW displays the start of each activity bout in the actogram as a small dot.  

•  EXPORT creates a file listing of the day, time, length, total counts, peak count and interbout 
interval for each identified bout. In addition, the average bout length and average number of 
bouts per day are reported in the file.  

•  LENGTH HISTOGRAM displays a histogram of the bout lengths. Type a number into the bins 
control to change the number of bins in the histogram.  

•  SERIAL CORRELATION displays a scatterplot of the interval between bout N+1 and N+2, 
plotted against the interval between bout N and N+1. A least squares fit is applied to the plot, and 
the parameters of the fit displayed.  

Two items in the Preferences window control how the Bouts are identified. A bout is a period during 
which the activity never falls below N counts per minute for longer than M minutes at a time, where N is 
the Bout threshold, and M is the Maximum Gap Length. Both of these paramters are set in the 
actogram Preferences window.  

Event Markers 

You may place an event marker anywhere in the Actogram by CNTL-clicking. A dialog appears in 
which you may type a descriptive label for the marker. The marker label appears when you run the 
cursor over the marker (rollover) and when the actogram is printed. To delete a marker, CNTL-click on 
it, and hit cancel in the label dialog. 

File Notes 

Selecting the Notes item in the ACTOGRAM menu opens a small window with a text edit box in it. 
Click anywhere in the box, type in the desired text, and click OK when finished. Notes specified in this 
manner will appear at the top of the actogram, periodogram, activity profile, Autocorrelogram and FFT. 
The notes are saved along with other actogram settings when the SAVE button in the Actogram Window 
is pressed. (The Save button is only visible when onsets are visible.) 

Printing the Actogram  

The Print V and Print H items in the ACTOGRAM menu allow you to print the actogram to the 
currently selected printer in either the Portrait or Landscape modes. The graph will fill the page. If you 
wish, MATLAB allows you to adjust the position and size of the graphs as they appear on the printed 
page using the “Page Position” item in the File menu. To use these setting, you must then print the 
actogram using the Print item in the MATLAB File menu. You will notice that the figure and axis labels 
will appear smaller in this case. (The CLOCKLAB print buttons adjust the font sizes before printing. 
The Matlab Print command bypasses this function.) You can compensate by selecting a larger font with 
the main window Font control, but the fonts might then look a little ungainly on the screen.  

Opening the Next File  

The Next File item in the ACTOGRAM menu opens the next (alphabetical) file in the current folder and 
displays its actogram using the current settings.  
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Altering the Actogram's Appearance 

A number of options can be set in the Main Control Window and the Preferences Window to alter the 
appearance of the Actogram. Details are described in the help files for the two windows. 
Menu Items 

LD Bar. When this item is checked, a bar appears above the actogram in which the light/dark cycle used 
during data collection can be displayed. Selecting this item will redraw the actogram: any editing of 
onsets or schedules will be lost.  

Show Dates. When this item is checked, the vertical axis on the actogram displays the dates of the data 
collection. Otherwise, the day numbers are displayed. 

Double plot. When this item is checked, the x-axis of the actogram becomes twice Tau, and each Tau-
length period of data is displayed twice, once to the right of and once below the data from the previous 
day. Selecting this item will redraw the actogram: any editing of onsets or schedules will be lost.  

•  Preferences window controls 

•  Show Data Gaps: Colored lines can be drawn in parts of the actogram to indicate where there 
are gaps in the data.  

•  Show Zero Lines: Black lines can be drawn across each line of the actogram at the zero level.  

•  Show Controls. When copying the actogram into the clipboard for transfer to a drawing 
program, it is sometimes useful to hide the various buttons and other controls in the actogram 
window. Use the Controls checkbox in the preferences window to do this.  

•  If light levels have been recorded (ClockLab or Actiwatch data), several controls can be used to 
alter the display of the light data.  

Saving the Actogram  

The Save control (visible only when onsets are displayed) saves the current state of the actogram to a 
file named "_filename-onsets.mat". The file is placed in the same directory as the data file. This file can 
only be read by Clocklab using the Read button. When the Read button is clicked, Clocklab searches 
for the _filename-onsets.mat file in the same directory as the data file. If the file exists, it is read and 
many features of the actogram that were set at the time the file was saved are restored. Saved features 
include the STARTDATE, ENDDATE, STARTHOUR, TAU, onset and offset times, least-square fits, 
predictions, markers and FILENOTES. A warning is briefly displayed if the _filename-onsets.mat file 
cannot be found. 

When the Open Onsets File option is checked in the Preferences window, Clocklab searches for the 
_filename-onsets.mat file and, if it finds the file, opens and applies the file automatically when the 
Actogram is first displayed.  
 

 

The Autocorrelation Window 
The Autocorrelation window shows a plot of the autocorrelation of the activity for the dates specified by 
the Start and End Dates menus. 
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The autocorrelation is defined as  

R(period) = Integral( a(t) * a(t + period)) 

where a(t) is the data stream (activity, temperature, heart rate, etc.) . 

The graph is normalized so that R(0) = 1.  

Shift click on the graph at any point to display the period and R value at that point. 

Bout Analysis 

Display Bouts by selecting BOUTS from the popup menu at the bottom left of the actogram.  

Four items in the BOUT submenu of the ACTOGRAM menu control bout analysis.  

•  SHOW displays the start of each activity bout in the actogram as a small dot.  

•  EXPORT creates a file listing of the day, time, length, total counts, peak count and interbout 
interval for each identified bout. In addition, the average bout length and average number of 
bouts per day are reported in the file.  

•  LENGTH HISTOGRAM displays a histogram of the bout lengths. Type a number into the bins 
control to change the number of bins in the histogram.  

•  SERIAL CORRELATION displays a scatterplot of the interval between bout N+1 and N+2, 
plotted against the interval between bout N and N+1. A least squares fit is applied to the plot, and 
the parameters of the fit displayed.  

Two items in the Preferences window control how the Bouts are identified. A bout is a period during 
which the activity never falls below N counts per minute for longer than M minutes at a time, where N is 
the Bout threshold, and M is the Maximum Gap Length. Both of these paramters are set in the 
actogram Preferences window.  

Event Markers 

You may place an event marker anywhere in the Actogram by CNTL-clicking. A dialog appears in 
which you may type a descriptive label for the marker. The marker label appears when you run the 
cursor over the marker (rollover) and when the actogram is printed. To delete a marker, CNTL-click on 
it, and hit cancel in the label dialog. 

File Notes 

Selecting the Notes item in the ACTOGRAM menu opens a small window with a text edit box in it. 
Click anywhere in the box, type in the desired text, and click OK when finished. Notes specified in this 
manner will appear at the top of the actogram, periodogram, activity profile, Autocorrelogram and FFT. 
The notes are saved along with other actogram settings when the SAVE button in the Actogram Window 
is pressed. (The Save button is only visible when onsets are visible.) 

 

The FFT Window 
The FFT is prepared from the portion of the file data specified by the Start Date, End Date and Start 
Hour controls in the main window. The FFT is normalized so that the integral of the graph is equal to 1.  



17

•  Shift-Click anywhere in the plot window to display the x- and y-values of a point in the graph. 
X-values are displayed both in frequency (cycles per hour) and in period (hours).  

•  Click-and-drag to zoom the x-axis of the graph.  

•  Double-Click to un-zoom.  

FFT plotting preferences 

Two options may be set in the FFT window using the check boxes at the lower left. Changing either 
setting causes the FFT to be plotted again. 

•  Power Spectrum. Determines whether a power spectrum or amplitude spectrum is displayed. 
The label on the Y axis ("relative amplitude" or "relative power") shows which option is 
selected.  

•  Blackman-Harris window. Determines whether a Blackman-Harris window is applied to the 
data prior to the FFT. When the window is applied, the text "(BH)" is appended to the file name 
in the upper left corner of the figure.  

These settings are saved in ClockLab configuration files (see the Main Window Save Settings control) 
and so are preserved from session to session.  
 

The Periodogram Windows 
Use the Periodogram popup menu in the Main Window to display a periodogram for the data portion 
specified by the Start Date, End Date and Start Hour controls in the main window. Three types of 
periodogram can be displayed: Chi-squared, F, and Lomb-Scargle (see below for a description of the 
different types). Each periodogram window has a set of controls: 
Set Tau. The x-axis location (period) of the peak of the periodogram is displayed near the peak itself in 
the blue text box. Pressing the Set Tau button sets the Tau menu in the Main ClockLab Window to 
Other, and changes the value in the Tau edit box to the x-axis location of the peak. 
    Try displaying an actogram with Tau set to 24 hours and applying the following sequence of 
commands: 

•  Zoom in on a region of the actogram with a fairly constant Tau, but one that is 
significantly different from 24 hours.  

•  Click the Set Dates button.  

•  Click the Periodogram button in the main window.  

•  Click the Set Tau button in the Periodogram window.  

•  Click the Actogram button in the main window.  

You should now have an actogram in which the activity onsets are aligned nearly 
vertically.  

Prefs. Opens a preferences window in which various settings for the Periodogram can be specified.(see 
Preferences Window). These include the start and end periods for the x-axis of the graph, the confidence 
level for the green significance line, whether arhythmic animals will be identified during batch analyses, 
font size and name for the graph labels, and the graph background color. 
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Export. Writes the data comprising the two graphs to a spreadsheet-compatible file with three columns: 
period (x-axis value), the corresponding chi-squared value (blue line), and the significance level (green 
line).  

Zoom/Unzoom. The y-axis of the periodogram can be zoomed/unzoomed by clicking-and-
dragging/double clicking in the graph window.  

Shift-click on any point in the graph to display it's coordinates, along with the significance level for that 
point. 
Averaging Periodograms: The average of individual chi-sq or F periodograms of several different 
animals can be prepared using the Batch Analysis window. In the Batch Analysis window, select either 
of the P'gram peak options, select the desired files, select the periodogram type, and press Go. At the 
end of the analysis, the average of the individual periograms will be displayed in the corresponding 
Periodogram Window. 

Note that periodograms can take a long time to calculate and consume considerable amounts of memory. 
To speed up the calculation, set BlockSize (Main window) to a larger value, set the Start and End 
Dates (Main Window) to a narrower range of data, or set the Start and End range for the periodogram 
(Preferences Window) to a smaller range. 

Chi-squared Periodogram 

Calculated after the method of Sokolove and Bushell (1978). For each period value on the x-axis of the 
graph, the data are cut into segments with that period. These segments are averaged together to give an 
activity profile and the standard deviation of the profile is calculated. The more consistent the waveform 
is in each segment, the larger the signal (standard deviation) will be in the average. This standard 
deviation is then normalized by the standard deviation of the entire data set. The chi-square line is 
plotted in green, using the confidence level (alpha) set in the Preferences Window. For a confidence 
level of 0.01, for example, the chances of random data exceeding the chi-square line at any one point is 
1/100. Chi-square is approximated according to Biostatistical Analysis by Jerrold H. Zar (Prentice Hall, 
1984). 

You may construct a periodogram from completely random data by typing "whperiod('init', 0)" at the 
prompt in the Matlab Command Window. With alpha set to 0.5, exactly half of the points in the 
simulated periodogram will be above the chi-square line. With alpha set to 0.1, 1/10th of the points will 
be above the chi-square line, etc. For almost all real data, most of the points in the periodogram, except 
for the peaks, lie far below the chi-square line, even with alpha set to 0.5. This occurs because even for 
animals that appear arrhythmic, the data points are not randomly distributed. So while the periodogram 
calculation (Blue line) is a very sensitive indicator of rhythmicity, the chi-square statistic (green line) is 
not an accurate indicator of the significance of a peak. It should be used only as a rough guideline.  

F Periodogram 

As for the chi-squared periodogram, the data are cut into segments with period p, and averaged together 
point by point to yield an activity profile. Instead of looking for a large signal in the activity profile, the 
F periodogram compares the activity profile to each of the individual segment of period p. The more 
similar these segments are to one another (the lower the standard deviation at each point in the segment), 
the higher periodogram value. See Dorrscheift and Beck (1975) for details. 

The green line in the periodogram plot displays the confidence levels (qs in Dorrsheift and Beck). With 
the periodogram confidence setting (see Preferences Window) at 0.01, for example, values above the 
green line in the periodogram window have a 99% chance of being significant. Note that the line can 
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currently be calculated only for confidence settings of 0.01, 0.025 and 0.05. For other settings, the line is 
plotted at zero.  

The F Periodogram give very similar results to the Chi-squared periodogram for many data sets, but is a 
little slow to calculate. 

Lomb-Scargle Periodogram 

The Lomb-Scargle periodogram is very different in character from the Chi-squared and F periodogram, 
relying instead on a form of Fourier spectral analysis. Its main strength is that it can handle records with 
large or frequent gaps more reliably that the Chi-squared or F periodogram. Imagine, for example, that 
data are sampled for several days, but with a gap of several hours occurring at a similar time each day. If 
these gaps were filled with zeroes and the data applied to a standard spectral analysis or periodogram, a 
24-period would emerge, even if no such rhythm were present in the animal's activity. The L-S 
periodogram avoids this artifact. Note that in by far the majority of cases, however, occasional gaps in a 
record will not create significant artifacts in the Chi-squared or F periodogram. 

To calculate the LS periodogram, for a given period the data are multiplied by a sine wave, squared and 
summed, then separately multiplied by a cosine wave, squared and summed. The resulting two sums are 
normalized and summed. The calculation is similar to that for a standard power spectrum, except that the 
sine and cosine waveforms used in the calculation contain gaps identical to those in the data set. See 
Press and Rybicki (1989) for an exact description of the algorithm. 

Confidence levels shown in the program (green horizontal line) are calculated as 

-ln(1 - exp(2/n - ln(1 - alpha)) 

where n is the number of sampled data points and alpha is the confidence limit chosen in the Preferences 
Window (0.001, 0.01, etc).Note that n, the number of data points used in the calculation, is affected by 
the BlockSize setting in the main window, and so is not directly related to the actual resolution of the 
data collection. For example, assume that the data were collected at 30 minute intervals and BlockSize is 
set to 5 minutes. ClockLab automatically resamples data into 1-minute intervals for its internal 
calculations, and so the 6 adjacent data points that cover each period of 30 minutes are not independent 
measures. As a result, the confidence level calculated for a blocksize of 5 will be inaccurate. Be sure to 
set the BlockSize control to a value equal or exceeding the sampling interval of your original data.  

In addition, the confidence level calculation above assumes normally distributed data points, which is 
not always a good assumption for circadian data.  

For a much more detailed consideration of the use of the LS periodogram, see Van Dongen et al. (1999). 
These authors have made available a Matlab routine for calculating the LS periodogram and for 
carefully evaluating the significance of the various peaks that appear in the periodogram.  
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The Time Series Window  
Displays the activity counts as a continuous function of time. Only the portion of the file specified by 
the main window START and END DATES controls is displayed. The BLOCKSIZE menu in the main 
window determines how many points per hour are displayed. The x-axis is labeled in days.  

Click or Click-and-drag on a portion of the graph to zoom in.  

Shift-click to zoom out. 

Double-click to zoom out to display the entire graph. 

Export prompts for a new file name. The y-values of each point in the plot are exported to the file in 
spreadsheet format. Note that Export differs from the Write File function in the main window. Write 
File creates files in ClockLab's native format and that can be read by Clocklab itself. Exported files 
cannot be read by ClockLab but can be read by text editing and spreadsheet programs. 
 

The Batch Analysis Window  
The controls in the Batch Analysis window are designed to start a batch Analysis on multiple files. Open 
the window by clicking the Batch Analysis button in the Main Window.  

The file list box to the left of the window list the directories and files contained within the current 
directory (that is, the directory that contains the last data file you opened). 

•  Double-click on ".." to move up one level to the directory that contains the current directory.  

•  Double click on one of the subdirectory names to move down a level.  

•  Click on a single file to select it for inclusion in the analysis.  

•  Shift-click on a single file to select all files between it and the most recently selected file.  

•  Control-click to select or deselect non-contiguous files.  

•  Control-click and drag to select multiple non-contiguous files.  

•  Select All and Unselect All select or unselect the entire list of files.  

Batch analyses. Click on the checkbox for an analysis to have it included in the output. Selecting an 
analysis makes visible the controls for setting its parameters. 

•  P'gram peak1.The TAU, amplitude, and significance value of the main peak of the 
periodogram, calculated from time period set in the start date and end date menus to the right 
of the checkbox. Note that if the "Indicate Arrhythia" checkbox is checked in the Preferences 
window, those animals for which the periodogram never rises above the significance line are 
indicated by "NaN" (Not a Number) in the batch output file.  
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•  P'gram peak2.The TAU, amplitude, and significance value of the second largest peak of the 
periodogram, calculated from time period set in the start date and end date menus to the right 
of the checkbox.  

•  Average Periodogram. This analysis does not have its own button. But at the end of the batch 
analysis, if either P'gram peak is selected, the periodogram that is now displayed is the 
AVERAGE of the periodograms of all the animals selected for analysis. The Chi-square line is 
deleted since it no longer has the same meaning it does for individual periodograms.The color of 
the plot also changes. Shift-click on the peak to find it's period and value.  

•  FFT Peak.The Tau and amplitude of the FFT calculated from data within the set time period.  

•  Onset Tau/Err. A least squares fit to the onsets within the specified period is constructed, and 
the Tau and error of the fit is reported (see Actogram Help).  

•  Phase angle. Two least squared fits are constructed. The first fit is calculated(from the onsets or 
offsets as determined by the onsets check box) starting on the StartDate and ending on the 
Target Day. The second fit is calculated from onsets (or offsets) starting on the Target Day and 
ending on the EndDate. The Phase shift is calculated from the two fits on the Target Day using a 
Tau of 24 hours.  

•  Avg counts. The average counts per minute for the specified period.  

•  Daytime activity. Reports the average number of counts per day during the alpha period, the rho 
period, and the total counts per day, and the percentage of counts that occurred during the alpha 
period. The menus to the right of the checkbox control the start date and end date for the 
calculation. The On and Off text boxes determine the alpha period (set in hours).  

•  Day 1 counts.The total counts for the 1st day of the file.  

•  Alpha. Fits are applied to the automatically identified activity onsets and offsets for the period 
specified in the start and end date menus next to the "alpha" checkbox. The mean horizontal 
distance between the two fitted lines is reported. This the same calculation that is reported in the 
"alpha" item of the FIT1 or FIT2 popup menus in the actogram window.  

Go. Perform the analysis. The analysis output is sent to a tab-delimited a file called "_batch" in the 
directory containing the analyzed files. 

Average Files. When this button is clicked, none of the batch analyses are performed. Instead, the count 
records from each of the selected files are averaged together to make a single virtual animal. The 
resulting averaged count record is loaded into the program and given the name of the currently selected 
folder. The virtual animal data can be analyzed exactly as if it were an individual animal, using all the 
tools available in ClockLab. 

•  Records are normalized prior to averaging: Each record is divided by the mean of the activity.  

•  Records are averaged starting at day 1, regardless of date.  

•  The start of each individual record is padded backwards from its start to midnight of the first day 
before averaging, so that the averaged record starts at midnight of the first day.  

•  If not all of the selected files are of the same length, the averaged record will be as long as the 
longest individual record. Shorter files are padded with zeros at the end before averaging.  
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•  It is up to the user to insure that each of the selected animals has been treated identically and in 
synchrony with one another relative to day 1 of the file. For example, two files need not have 
been collected starting on the same day. If, however, each animal has been treated with a light 
pulse, the pulse should occur at the same time relative to the starting day of the files.  

Median Files. Similar to Average Files, but instead of averaging the records of the selected files, the 
point-by-point median of the selected files is calculated. No normalization is performed on the 
individual records prior to the median calculation.  
Note: The median calculation is extremely memory intensive. If you encounter an Out of Memory error 
on the Macintosh, quit Matlab, find and select the Matlab application icon, and type COMMAND 
(APPLE) - I. Select Show Memory, and increase the preferred size. On the PC, when memory is tight, 
the loading of the individual files will slow down dramatically as Matlab starts to use virtual memory. 
Quit all other applications to free up as much memory as possible. 
Save Config. Saves the checkboxes and parameters into the main configuration file so that they are 
restored the next time the window is opened. 

Cancel. Closes the window. 
 

The Batch Print Window  
The controls in the Batch Print window are designed to start a batch printing of actograms or 
periodograms for multiple files. Open the Batch Print window by clicking the Batch Print button in the 
Main Window.  

The file list box to the left of the window list the directories and files contained within the current 
directory (that is, the directory that contains the last data file you opened). 

•  Double-click on ".." to move up one level to the directory that contains the current directory.  

•  Double click on one of the subdirectory names to move down a level.  

•  Click on a single file to select it.  

•  Shift-click on a single file to select all files between it and the nearest already-selected file.  

•  Control-click to select or deselect non-contiguous files.  

•  Control-click and drag to select multiple non-contiguous files.  

•  Use the Select All and Unselect All buttons to the right when needed.  

Layout. You may have each graph printed on a separate sheet of paper, or have several graphs tiled onto 
a single page. If you select "3 x 3", for example, the selected files will be printed 9 to a page. The last 
page printed may have fewer than 9 graphs on it, depending on how many are selected from the file list. 
When the "Y Scale" menu in the Main Window is set to "fixed", only one actogram from each file is 
printed with the selected number of lines starting from the Start Date setting in the main window.  
Note: When actograms are printed 1 to a page, you may use the Show Onsets option in the Preferences 
Window to have the actograms printed with automatically-identified activity onsets visible. In addition, 
the Open Onsets File option will automatically open and read any existing _filename-onsets.mat files 
(See Saving the Actogram). 
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Actogram/Periodogram/Activity Profile. Determines whether actograms or periodograms or Activity 
profiles are displayed and printed for the selected files.  

Print. Once the files are selected click the Print button. Each file will be opened in turn, an actogram or 
periodogram displayed and then printed to the currently selected printer. Actograms will be displayed 
using the settings in the Main window.  

Portrait/Landscape. These buttons determine whether the printouts will appear in portrait or landscape 
mode (vertical or horizontal on the page).  

Done. Closes the window. You may also use the standard close-box in the window’s tool bar.  

Printing portions of the data in the selected files: Each file is opened using the "Preserve Dates" 
option in the Preference Window. To print each file in its entirety, no matter what the starting and 
ending dates, uncheck the "Preserve Dates" option. To print the same portion of each file, select the 
Preserve Dates option and set the Start and End Date menu in the Main Window. The whole file will be 
printed for those cases in which the date range of the file does not overlap the date range selected. 
 
 


